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(UltraAccounts users need to upgrade to UltraAccounts ←↩
3.2)

1.2 Overview

OVERVIEW
--------

Quite simply, PayAdvice is an extremely intuitive & easy-to-use database
program designed specially for keeping a computerized record of all your
payslips.

Have you ever been curious about just how much of your hard-earned wages
ends up in the hands of the tax man? Or have you ever wondered about how
much has been paid into the company pension fund? Or how much you’ve been
paid in overtime for all those extra hours you’ve been working?

This program can add it up for you and tell you instantly, without the
chore of sorting through all your old payslips and then working it out
using a calculator...

Likewise, if you ever need to find a specific payslip for any reason (for
example, because you want to check how much tax you’ve been paying) then
you’ll be able to simply look up the required details on your computer
instead of having to rummage through boxes upon boxes of paperwork while
you try to find the appropriate payslips.

Finally, perhaps one of the most obvious reasons for keeping a database of
your wage details on the computer is that you’ll finally be able to throw
out all those dusty old payslips *without* losing any of the information
that was stored on them!

1.3 Requirements & Tooltypes

REQUIREMENTS
------------

Requires at least 1 meg of memory, and Kickstart 2.0 or higher. Although
not essential to use the program, a hard drive and extra memory are both
recommended.

Hard drive installation is simply a matter of dragging the PayAdvice drawer
to an appropriate place on your hard drive. Registered users need to make
sure that their keyfile is in the same drawer as the program itself!

PayAdvice uses reqtools.library by Nico François & Magnus Holmgren.

TOOLTYPES
---------
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You can set the following tooltypes in the PayAdvice program icon:

DEFAULTFILE=<filename>
The file "<filename>" will be automatically loaded for you each
time you use the program - remember to include the full path if
it isn’t in the PayAdvice drawer! You’ll still need to type the
password (if you’ve used one) but it’ll save you from having to
use the file requester every time...

SCREENMODE=CUSTOM or WORKBENCH
Select whether PayAdvice should use the Workbench screen or its
own custom screen. This can also be changed by selecting one of
the options from the "Options/Screen mode" menu in the program.

BACKUPS=NO
When you save your file PayAdvice normally renames the previous
file and keeps it as a backup copy, just in case something goes
wrong corrupting your data. Selecting this will *prevent* these
backups from being made.

1.4 Getting started

GETTING STARTED
---------------

Simply double-click on the icon to load PayAdvice, and the main PayAdvice
window will appear.

The first thing that you’ll need to do is configure the program to deal
with the particular combination of additions & deductions that appear on

*your* payslips. This is done automatically the first time you enter a
payslip, but if you prefer to do it manually then all you have to so is
select "Edit/Wage titles" from the menu in the PayAdvice window.

Manually configuring the program
The PayAdvice window itself simply consists of a list which ←↩

displays a
summary of all your payslips, together with a button for entering new
payslips.

Each time you (or your partner) receives a new payslip, all you have to do
is press the "New entry" button, and a window will appear for you to select
who’s wages you’re entering. Once you’ve clicked the appropriate button, a
calendar will appear for you to enter the date of the new payslip, and then
the payslip window itself will appear: You’ll see a list showing the names
of all your additions and deductions, together with a box at the bottom of
the window displaying the name of your first addition. Just enter the
appropriate amount, and then press return - the name of your next addition
(or deduction) will then be displayed, and so on until all the required
details have been entered. You can go back and change any of the amounts
that you’ve entered by simply using the mouse to click on the required
entry in the list. Just press the "OK" button when you’re finished, and a
summary of the new payslip will be added to the list in the main PayAdvice
window.
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To edit (or erase) a payslip, simply click on its entry in the list. The
payslip window will be displayed again, where you can now edit any of the
details, or use the "Erase" button to delete that particular payslip.
Pressing the "Print" button in the payslip window will make a printout of
the details for that particular payslip.

You can scroll up and down through the list by using the mouse to drag the
scroll-bar on the right-hand side of the window.

There’s also a number of pull down menu’s available:

Menu functions

1.5 Saving your payslip file

SAVING YOUR PAYSLIP FILE
------------------------

Because all wage details are confidential, this program saves its files
using an encrypted (and optionally password protected) format - making it
impossible to reload a PayAdvice file without first entering the correct
password.

Selecting "Project/Save" from the menu will simply save your file using the
same filename & password that were used to load it, to save you from having
to go through the file requester and enter your password again.

Using "Project/Save as" asks you to enter both the filename and password.

You can enter anything that you want for the password, up to ten characters
long, but remember that passwords ARE case sensitive (so "a" is different
to "A"). But, if you forget what you’re password is, then you won’t be able
to reload your file.

If you don’t want to use a password at all then just press the "Return" key
when asked for the password. Then, whenever you load your file, it will be
loaded directly without asking you to enter the password again.

As you type, you’ll notice that a "*" is displayed for each character of
your password - this is to prevent anybody from reading your password on
the screen while you’re typing it. If you’ve just entered a new password
then you’ll be asked to type it a second time simply to confirm that you
didn’t make any typing mistakes when you entered it - entering different
text at the second prompt will cause a warning to be displayed!

I’d suggest starting a new payslip file each year, and saving them with
filenames like "FredBloggs1996" for your 1996 payslips while working for
Fred Bloggs (or whatever!). If you’d prefer to keep larger files than that,
then the program can store up to 250 payslips in each file - which, if you
get paid weekly, is about five years worth!
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1.6 Configuring the wage categories

CONFIGURING THE WAGE CATEGORIES
-------------------------------

As you know, all wage packets consist of numerous additions and deductions
to your earnings, such as basic pay, overtime and tax - but the actual
combinations of those individual additions & deductions can vary wildly
from one person to another.

This program can handle several different payslip configurations at the
same time, making it ideal for entering both you and your partners wage
details in the same payslip file. Each separate payslip configuration can
consist of up to eighteen additions and eighteen deductions, which should
be more than enough for most people!

There are two ways of setting up a new wage category...

Firstly, the automatic way: When you press the "New entry" button in the
main PayAdvice window, a window pops up asking you to select a category for
the new payslip. Normally, you’d just select "My payslips" (or whatever!)
to use that particular configuration, but if you instead select one of the
unused categories then the configuration window will appear for you to
enter all the details for the new category.

The second way of doing it is to simply select "Edit/Wage titles" from the
menu in the PayAdvice window. Clicking on either an existing (or unused)
category will display the configuration window, where you can enter/edit
all the appropriate information.

Either way, all you have to do is type the names of all those individual
additions & deductions into the on-screen boxes - for example, you might
put "Basic pay" in the first additions-box, and "Overtime" in the second,
and so forth. Pressing the cycle-gadget at the bottom of the window will
cycle the display between your additions & deductions.

Incidentally, you don’t need to worry about any of the totals (e.g. total
gross, or total deductions) while entering the names of all your additions
and deductions - these are automatically created and dealt with by the
program itself!

You’ll notice that the "UltraAccounts a/c" and "Tag" buttons at the top of
the window can’t be used: These buttons are only available to UltraAccounts
users who are using PayAdvice to enter their payslips in their accounts
(they’re actually used for selecting which account & tag to use for your
payslips when the program automatically enters them in UltraAccounts - and
hence they can only be used when this window is called up from within the
UltraAccounts program, rather than from PayAdvice)

1.7 Common entries

COMMON ENTRIES
--------------
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If you’re paid a fixed salary rather than an hourly rate (for example) then
it’s quite possible that some of your additions or deductions will always
have exactly the same value week-after-week, month-after-month. Instead of
having to continually re-type exactly the same information everytime you
enter a new payslip, you can predefine these common entries and have the
program enter them for you.

Select "Edit/Common entries" from the menu in the PayAdvice window, and
then select the appropriate wage category.

A window will appear showing the names of all the additions and deductions
to your wages (use the cycle-gadget to switch the display between additions
and deductions). To predefine a value for any of your payslip entries, all
you have to do is enter the required amount in the appropriate box.

Then, each time you enter a new payslip, that amount will automatically be
entered for you for that particular addition/deduction - saving you from
having to type it in yourself.

1.8 Menu functions

MENU FUNCTIONS
--------------

The following pull down menu’s are available from the PayAdvice window:

Project

Edit

Tools

Options

1.9 Project menu

The "Project" menu contains the following functions:

NEW
Start a new payslip file.

OPEN
Load a new file. Use the file requester to enter the filename, and
then type your password.

SAVE
Save your file, automatically using the same filename & password
that you used while loading it.

SAVE AS
Save your file. Enter your filename using the file requester, and
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then type your password.

PRINT CATEGORY
Print the payslips that have been entered in a specific category.
Just select the required category, enter the start & finishing
dates, and then press the "Print" button.

PRINT ALL
Make a printout of all the payslips, regardless of which category
they’ve been entered into. Again, just enter the start & finish
dates and then press the "Print" button.

ABOUT
Displays some information about the program and its authors.

QUIT
Quit the program. Requesters will warn you if you’ve got any
unsaved information in your file.

1.10 Goto menu

The "Edit" menu contains the following functions:

WAGE TITLES

Create/edit wage categories
COMMON ENTRIES

Define/edit common entries

1.11 Tools menu

The "Tools" menu contains the following functions:

TOTALS
Calculate totals of all the various additions and deductions on
your payslips. Select which wage category you want to use, and a
window will appear listing the totals for that category. You can
change the start & end dates by pressing the date buttons at the
top of the window.

GRAPH
Plot a graph of your payslips. Again, select which wage category
to use, and a second window will appear asking you to choose which
additions & deductions you’d like to include on the graph. If you
select either "Total gross" or "Total deductions", then an outline
will be drawn to show you the proportion of the selected additions
and deductions against the total.

Could be useful for various things, such as comparing the exact
proportion of your gross pay again all those deductions, or even
for simple things like *seeing* how big a pay increase you’ve
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received (and how much extra tax you’re now paying as a result!)

FIND
Search for a specific value. Enter the amount that you want to
find, and the program will then search through all your payslips
looking for the required value.

1.12 Options menu

The "Options" menu contains the following functions:

SCREEN MODE » CUSTOM/WORKBENCH
Select whether PayAdvice should use the Workbench screen or its
own custom screen. This can also be changed using the tooltypes
settings in the PayAdvice icon.

KEEP BACKUPS
When you save your file PayAdvice normally renames the previous
file and keeps it as a backup copy, just in case something goes
wrong corrupting your data. Turning this off will *prevent* the
program from keeping these backups - again, this can be set via
tooltypes.

1.13 The traditional jokes

THE TRADITIONAL JOKES
---------------------

That’s right, it’s time for more of my favourite jokes...

What should you do if you see a space man?
Park in it, man!

Why did the chicken cross the playground?
To get to the other slide!

Ha ha ha ha ha... Ahem...

1.14 Becoming a registered user

BECOMING A REGISTERED USER
--------------------------

This program is shareware, if you like it then please register by sending
FIVE POUNDS STERLING to me at this address:

Richard Smedley
PO Box 59
SUTTON-IN-ASHFIELD
Nottinghamshire
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NG17 3HP
England

rsmedley@cix.compulink.co.uk

I’ll send a personalised keyfile to everyone who registers, which will
disable the shareware reminders in this and all future versions.

If you want to send *cash* from abroad, then I’ll accept the equivalent
amount in most currencies (I’d prefer either US Dollars, Deutschmarks, or
Australian Dollars, but will probably accept most others too!) Just make
sure that you hide the money fairly well in the envelope, to stop it from
being opened before it reaches me. Or, alternatively, you could register by
sending me a CD-Rom title or something similar...

Of course, registered users from any previous versions of PayAdvice can
obtain a free keyfile by simply sending a blank disk plus SAE to me at the
above address.

PS. Please don’t worry about the fact that I’m now using a PO Box - I’ll be
moving house at the end of this year (and probably moving again next year),
so I’ve started using a PO Box simply to avoid all the potential problems
which can be caused by letters being lost and/or not forwarded due to the
address changes. If you’re wary about using PO Boxes then please feel free
to write or e-mail me before you register, to confirm that this address is
genuinely valid.

1.15 Acknowledgements
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1.16 Version history
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VERSION HISTORY
---------------

V1.2 (16.11.96)

- Bug fix: In the "Edit titles" and "Common entries" windows, clicking
out of a string gadget with the mouse, instead of pressing either the
CR or TAB key, would sometimes cause the contents of the string gadget
to be lost.

- Saved files are now a *lot* smaller (what was previously a 29K file is
now only 4K!!), speeding up loading & saving.

- Now uses proper GT menus instead of intuition ones.

- Added a "Project/New" menu item, for starting new PayAdvice files.

- When selecting the start/end dates on totals & printouts, selecting a
non-existant date now gives you a "Cancel" option instead of forcing
you to go back and enter a new date on the calendar.

V1.1 (29.09.96)

- All new versions of this program will now be supplied with a PGP
signature, making it easy for the user to check the integrity of
the program (remove the risk of viruses, etc.)

- Now supports up to 18 additions & deductions in each wage category
(useful for anybody who has to pay local taxes etc.)

- Incorporated "Common entries", allowing you to predefine the details
of any additions/deductions which always have the same value on all
your payslips.

- Numerous changes to the user interface. Where appropriate, additions
and deductions are now "paged" using cycle-gadgets.

- If your additions/deductions ever change for any reason, then your
previous payslips will now still retain their original titles.

- Bug fix: No longer crashes when unable to open reqtools.library

V1.0 (17.07.96)

- The first release of a brand-new, next generation PayAdvice program!

1.17 Copyright & Disclaimer

COPYRIGHT & DISCLAIMER
----------------------

UltraPayAdvice 1.2 is Copyright © Richard Smedley 1996, All Rights
Reserved.
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Unregistered versions of this program can be freely distributed for
non-commercial purposes providing all the original files remain fully
intact and unmodified, with no files added or removed.

Registered copies of this program, and the keyfiles sent to registered
users, must not be copied or distributed in any way.

This software is provided "as is", without any warranty either expressed or
implied. In no event will the author be liable for any direct, indirect,
incidental or consequential damages or loss of data resulting from the use
of this software. The entire risk as to the results and performance of this
software is assumed by the user.

Reqtools.library is Copyright © Nico François & Magnus Holmgren.

The icon was designed by Magnus Enarsson.

1.18 Archive contents & PGP info

ARCHIVE CONTENTS & PGP INFO
---------------------------

The complete, unregistered program consists of the following files (and

*only* these files!)

PayAdvice (the PayAdvice program)
PayAdvice.sig (PGP signature for PayAdvice)
PayAdvice.info (program icon)
PayAdvice.Guide (the instructions - you’re reading them!)
PayAdvice.Guide.info (instructions icon)
PayAdvice.Readme (brief summary about the program)
PayAdvice.Readme.info (readme icon)
reqtools.library (required library)

If you’ve got access to PGP, then make sure that you use the PGP signature
to check the integrity of PayAdvice *before* using the program. My public
PGP key is below - you’ll find my PGP key fingerprint in my on-line resume
on CIX, or just drop me a line and ask for it.

To actually check the integrity of the PayAdvice executable, all you have
to do is add my public key to your PGP keyring and then type the following
in a Shell window...

PGP PayAdvice.sig PayAdvice

...and a message will be displayed telling you whether or not it’s safe to
use this copy of the program.

Here is my public PGP key:

-----BEGIN PGP PUBLIC KEY BLOCK-----
Version: 2.6ui (Amiga)

mQBNAjBJ2LQAAAECALAYBocjm5+3UrkFD5HmaorNemB6vCh/7Y/MhgAZ823ZA3kR
mdIVlBntq5oxClX+EC916E034j5H7E67hrkmHM0ABRG0LlJpY2hhcmQgU21lZGxl
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eSA8cnNtZWRsZXlAY2l4LmNvbXB1bGluay5jby51az4=
=OejG
-----END PGP PUBLIC KEY BLOCK-----
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